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All BlogsExcel ResourcesAdd-ins in ExcelData Analysis and ToolsAdd-InsAdd-ins in ExcelAnalysis ToolPak In ExcelData ConsolidationConsolidate Function In ExcelData Analysis and ToolsGET: WSM ALL COURSES ACCESSDownload FREE Add-ins Excel Template and Follow Along!Add-ins Excel Template.xlsxTable Of ContentsAn add-ins is an
extension that adds more features and options to Microsoft Excel. Providing additional functions to the user increases the power of Excel. An add-in needs to be enabled for usage. Once enabled, it activates as Excel is started.For example, Excel add-ins can perform tasks like creating, deleting, and updating the data of a workbook. Moreover, one can
add buttons to the Excel ribbon and run custom functions with add-ins.The Solver, Data Analysis (Analysis ToolPak), and Analysis ToolPak-VBA are some essential add-ins.The purposes of activating add-ins are listed as follows: -To interact with the objects of ExcelTo avail an extended range of functions and buttonsTo facilitate the setting up of
standard add-ins throughout an organizationTo serve the varied needs of a broad audienceln Excel, one can access several Add-ins from “Add-ins” under the “Options” button of the "File" tab. In addition, one can select from the drop-down “Manage” in the “Add-ins” window for more add-ins.By default, it might hide some add-ins. One can view the
unhidden add-ins in the "Data" tab on the Excel ribbon. For example, it is shown in the following image.If Excel is not displaying the add-ins, they need to be installed. The steps to install Excel add-ins are listed as follows: First, click on the “File” tab located at the top left corner of Excel. Click “Options,” as shown in the following image. The “Excel
Options” window opens. Select “Add-ins.” There is a box to the right of "Manage" at the bottom. Click the arrow to view the drop-down menu. Select "Excel add-ins" and click "Go." The “Add-ins” dialog box appears. Select the required checkboxes and click “OK.” We have selected all four add-ins. The “Data Analysis” and “Solver” options appear under
the “Data tab” of the Excel ribbon. The types of add-ins are listed as follows:Inbuilt add-ins: These are built into the system. One can unhide them by performing the steps listed under the preceding heading (how to install add-ins in Excel?).Downloadable add-ins: These can be downloaded from the Microsoft website (www.office.com).Custom add-

ins: These are designed to support the basic functionality of Excel. They may be free or chargeable. ChartExpo is an example of a custom add-in, offering advanced charting tools to enhance Excel's data visualization capabilities. The "Data Analysis Tools" pack analyzes statistics, finance, and engineering data.The various tools available under the
"Data Analysis" add-in are shown in the following image.Generally, an add-in is created with the help of VBA macros. Let us learn to create an add-in (in all Excel files) for a custom function. For this, first, we make a custom function.Let us consider some examples.We want to extract comments from specific cells of Excel. Then, create an add-in for the
same.The steps for creating an add-in and extracting comments from cells are listed as follows: Step 1: Open a new workbook. Step 2: Press the shortcut “ALT+F11” to access the “Visual Basic Editor.” The following image shows the main screen of Microsoft Visual Basic for Applications. Step 3: Click “Module” under the “Insert” tab, shown in the
following image. Step 4: Enter the following code in the “module” window. Function TakeOutComment(CommentCell As Range) As StringTakeOutComment = CommentCell. Comment.TextEnd Function Step 5: Once the code is entered, save the file with the type “Excel add-in.” Step 6: Open the file containing comments. Step 7: Select " Options " in
the "File" tab and select "Options." Choose "Add-ins." In the box to the right of "Manage," select "Excel Add-ins." Click "Go." Click the "Browse" option in the "Add-ins" dialog box. Step 8: Select the add-in file that had been saved. Click “Ok.” We saved the file with the name "Excel Add-in." Step 9: The workbook's name (Excel Add-in) that we had
saved appears as an add-in, as shown in the following image. This add-in can be applied as an Excel formula to extract comments. Step 10: Go to the sheet containing comments. The names of three cities appear with comments, as shown in the following image. Step 11: In cell B1, enter the symbol "equal to" followed by the function's name. Type
"TakeOutComment," as shown in the following image. Step 12: Select cell Al as the reference. It extracts the comment from the mentioned cell. Since there are no comments in cells A2 and A3, the formula returns “#VALUE!.”We want to hide Excel worksheets except for the active sheet. Create an add-in and icon on the Excel toolbar for the
same.The steps to hide worksheets (except for the currently active sheet) and, after that, create an add-in and icon are listed as follows: Step 1: Open a new workbook. Step 2: In the “Visual Basic” window, insert a “Module” from the Insert tab. The same is shown in the following image. Step 3: Copy and paste the following code into the module. Sub
Hide All Worksheets ()Dim As WorksheetFor Each Ws In ActiveWorkbook.WorksheetsIf Ws.Name ActiveSheet.Name ThenWs.Visible = xISheetVeryHiddenEnd IfNext WsEnd Sub Step 4: Save this workbook with the type “Excel add-in.” Step 5: Add this add-in to the new workbook. For this, click “Options” under the “File” tab. Select “Add-ins.” In the
box to the right of “Manage,” select “Excel add-in” Click “Go.” In the “Add-ins” window, choose “Browse.” Step 6: Select the saved add-in file. Click “Ok.” We have saved the file with the name “Hide All Worksheets.” Step 7: The new add-in “Hide All Worksheets” appears in the “Add-ins” window. Step 8: Right-click the Excel ribbon and select
“Customize the Ribbon.” Step 9: The “Excel Options” window appears. Click “Quick Access Toolbar.” Under the drop-down of “Choose commands from,” select “macros.” In the box following this drop-down, choose the name of the macro. Then, click “Add” followed by “OK.” The tasks of this step are shown with the help of black arrows in the
following image. Step 10: A small icon appears on the toolbar. Clicking this icon hides all worksheets except for the currently active sheet. If we want to unhide the sheets hidden in the preceding example (example #2). Create an add-in and toolbar icon for the same.The steps to unhide the sheets and, after that, create an add-in and toolbar icon are
listed as follows: Step 1: Copy and paste the following code to the “Module” inserted in Microsoft Visual Basic for Applications. Sub UnHide All HiddenSheets ()Dim Ws As WorksheetFor Each Ws In ActiveWorkbook.WorksheetsWs.Visible = xlISheetVisibleNext WsEnd Sub Step 2: Save the file as “Excel add-in.” Add this add-in to the sheet. Right-click
the Excel ribbon and choose the option "Customize the ribbon." Then, in the "Quick Access Toolbar," select "Macros" under the drop-down of "Choose commands from."Choose the macro's name, click "Add" and "OK." The tasks of this step are shown with the help of black arrows in the following image. Step 3: Another icon appears on the toolbar.
Clicking this icon unhides the hidden worksheets. The points to be observed while working with add-ins are listed as follows: First, remember to save the file in Excel's "Add-in" extension of Excel. Be careful while selecting the add-ins to be inserted by browsing in the "Add-ins" window. Note: It is possible to uninstall the unnecessary add-ins at any
time. Today’s article explains everything you need to know about how to install an Excel add-in - or plugin, as it’s also known. We’ll show you what it is, why it’s essential for Excel, and how to install this type of Excel file. Read our step-by-step tutorial on how to install an Excel add-in quickly. Furthermore, download various free add-in collections! An
add-in is an Excel file that contains VBA modules. The file extension is “.xla” (in earlier Excel versions) or “.xlam” (in Excel 2007 and above). In most cases, an add-in is a ribbon-controlled application. You can use the main functions through custom buttons, tabs, and drop-down lists. After the successful installation, the add-in will start when Excel is
opened. Using custom UI and a little XML manipulation, you can design graphical user interfaces like this: No matter the name, every Excel add-in is installed similarly. Just follow these simple steps for any add-in installation. Installing an add-in is not rocket science; you must follow the simple steps below. If the package has a .zip extension, extract
it. We recommend creating a folder named “DataXL” (or whatever you want). After that, copy or move it to your preferred folder, for example, your Documents folder. Go to the ribbon and click the Developer tab. Click the Excel add-ins button. A new window will appear. Optional step: Learn how to enable the Developer tab on the ribbon if you have
not seen it. Click Browse and locate the add-in file. Open the File Explorer and navigate to the folder containing your add-in file. Select the file and click “OK” to add it to the list of available add-ins. Once the file is selected, it should appear in the list of available add-ins. Make sure it is checked, then click “OK” to enable it. If you are in a hurry, watch
our video about how to install the add-in quickly. We have to make two side notes here. After the successful installation, you have to move the add-in to a trusted location unblock the add-in (for security reasons) DataXL is a free productivity suite for Excel with many time-saving solutions. DataFX is our latest project. We’ve just picked the best Excel
user-defined functions and implemented them into one efficient tool. Additional resources How to fix the disappearing add-in ribbon? All BlogsExcel ResourcesAdd-ins in ExcelData Analysis and ToolsAdd-InsAdd-ins in ExcelAnalysis ToolPak In ExcelData ConsolidationConsolidate Function In ExcelData Analysis and ToolsGET: WSM ALL COURSES
ACCESSDownload FREE Add-ins Excel Template and Follow Along!Add-ins Excel Template.xlsxTable Of ContentsAn add-ins is an extension that adds more features and options to Microsoft Excel. Providing additional functions to the user increases the power of Excel. An add-in needs to be enabled for usage. Once enabled, it activates as Excel is
started.For example, Excel add-ins can perform tasks like creating, deleting, and updating the data of a workbook. Moreover, one can add buttons to the Excel ribbon and run custom functions with add-ins.The Solver, Data Analysis (Analysis ToolPak), and Analysis ToolPak-VBA are some essential add-ins.The purposes of activating add-ins are listed as
follows: -To interact with the objects of ExcelTo avail an extended range of functions and buttonsTo facilitate the setting up of standard add-ins throughout an organizationTo serve the varied needs of a broad audienceln Excel, one can access several Add-ins from “Add-ins” under the “Options” button of the "File" tab. In addition, one can select from
the drop-down “Manage” in the “Add-ins” window for more add-ins.By default, it might hide some add-ins. One can view the unhidden add-ins in the "Data" tab on the Excel ribbon. For example, it is shown in the following image.If Excel is not displaying the add-ins, they need to be installed. The steps to install Excel add-ins are listed as follows: First,
click on the “File” tab located at the top left corner of Excel. Click “Options,” as shown in the following image. The “Excel Options” window opens. Select “Add-ins.” There is a box to the right of "Manage" at the bottom. Click the arrow to view the drop-down menu. Select "Excel add-ins" and click "Go." The “Add-ins” dialog box appears. Select the
required checkboxes and click “OK.” We have selected all four add-ins. The “Data Analysis” and “Solver” options appear under the “Data tab” of the Excel ribbon. The types of add-ins are listed as follows:Inbuilt add-ins: These are built into the system. One can unhide them by performing the steps listed under the preceding heading (how to install
add-ins in Excel?).Downloadable add-ins: These can be downloaded from the Microsoft website (www.office.com).Custom add-ins: These are designed to support the basic functionality of Excel. They may be free or chargeable. ChartExpo is an example of a custom add-in, offering advanced charting tools to enhance Excel's data visualization
capabilities. The "Data Analysis Tools" pack analyzes statistics, finance, and engineering data.The various tools available under the "Data Analysis" add-in are shown in the following image.Generally, an add-in is created with the help of VBA macros. Let us learn to create an add-in (in all Excel files) for a custom function. For this, first, we make a
custom function.Let us consider some examples.We want to extract comments from specific cells of Excel. Then, create an add-in for the same.The steps for creating an add-in and extracting comments from cells are listed as follows: Step 1: Open a new workbook. Step 2: Press the shortcut “ALT+F11” to access the “Visual Basic Editor.” The following
image shows the main screen of Microsoft Visual Basic for Applications. Step 3: Click “Module” under the “Insert” tab, shown in the following image. Step 4: Enter the following code in the “module” window. Function TakeOutComment(CommentCell As Range) As StringTakeOutComment = CommentCell. Comment.TextEnd Function Step 5: Once the
code is entered, save the file with the type “Excel add-in.” Step 6: Open the file containing comments. Step 7: Select " Options " in the "File" tab and select "Options." Choose "Add-ins." In the box to the right of "Manage," select "Excel Add-ins." Click "Go." Click the "Browse" option in the "Add-ins" dialog box. Step 8: Select the add-in file that had
been saved. Click “Ok.” We saved the file with the name "Excel Add-in." Step 9: The workbook's name (Excel Add-in) that we had saved appears as an add-in, as shown in the following image. This add-in can be applied as an Excel formula to extract comments. Step 10: Go to the sheet containing comments. The names of three cities appear with
comments, as shown in the following image. Step 11: In cell B1, enter the symbol "equal to" followed by the function's name. Type "TakeOutComment," as shown in the following image. Step 12: Select cell Al as the reference. It extracts the comment from the mentioned cell. Since there are no comments in cells A2 and A3, the formula returns
“#VALUE!.”We want to hide Excel worksheets except for the active sheet. Create an add-in and icon on the Excel toolbar for the same.The steps to hide worksheets (except for the currently active sheet) and, after that, create an add-in and icon are listed as follows: Step 1: Open a new workbook. Step 2: In the “Visual Basic” window, insert a
“Module” from the Insert tab. The same is shown in the following image. Step 3: Copy and paste the following code into the module. Sub Hide All Worksheets ()Dim As WorksheetFor Each Ws In ActiveWorkbook.WorksheetsIf Ws.Name ActiveSheet.Name ThenWs.Visible = xISheetVeryHiddenEnd IfNext WsEnd Sub Step 4: Save this workbook with
the type “Excel add-in.” Step 5: Add this add-in to the new workbook. For this, click “Options” under the “File” tab. Select “Add-ins.” In the box to the right of “Manage,” select “Excel add-in” Click “Go.” In the “Add-ins” window, choose “Browse.” Step 6: Select the saved add-in file. Click “Ok.” We have saved the file with the name “Hide All
Worksheets.” Step 7: The new add-in “Hide All Worksheets” appears in the “Add-ins” window. Step 8: Right-click the Excel ribbon and select “Customize the Ribbon.” Step 9: The “Excel Options” window appears. Click “Quick Access Toolbar.” Under the drop-down of “Choose commands from,” select “macros.” In the box following this drop-down,
choose the name of the macro. Then, click “Add” followed by “OK.” The tasks of this step are shown with the help of black arrows in the following image. Step 10: A small icon appears on the toolbar. Clicking this icon hides all worksheets except for the currently active sheet. If we want to unhide the sheets hidden in the preceding example (example
#2). Create an add-in and toolbar icon for the same.The steps to unhide the sheets and, after that, create an add-in and toolbar icon are listed as follows: Step 1: Copy and paste the following code to the “Module” inserted in Microsoft Visual Basic for Applications. Sub UnHide All HiddenSheets ()Dim Ws As WorksheetFor Each Ws In
ActiveWorkbook.WorksheetsWs.Visible = xISheetVisibleNext WsEnd Sub Step 2: Save the file as “Excel add-in.” Add this add-in to the sheet. Right-click the Excel ribbon and choose the option "Customize the ribbon." Then, in the "Quick Access Toolbar," select "Macros" under the drop-down of "Choose commands from."Choose the macro's name, click
"Add" and "OK." The tasks of this step are shown with the help of black arrows in the following image. Step 3: Another icon appears on the toolbar. Clicking this icon unhides the hidden worksheets. The points to be observed while working with add-ins are listed as follows: First, remember to save the file in Excel's "Add-in" extension of Excel. Be
careful while selecting the add-ins to be inserted by browsing in the "Add-ins" window. Note: It is possible to uninstall the unnecessary add-ins at any time. Let us look at each of these methods in detail. Download the Excel Workbook below to follow along and understand How to Easily Install Excel Add-ins - download excel workbookInstall-Excel-Add-
ins.xlsx Installing an Add-in Through the Excel Ribbon Let’s say we have data on some of the world’s largest companies and their employee population. We want to quickly create a visual reference that will display this information. There are plenty of Excel Add-ins we can utilize for data visualization. There are basically two ways to install and use an
Add-in in Excel. Let’s start with the most straightforward method: Got to the Home tab in the Excel Main Ribbon. In the Add-Ins group, click on Add-ins. From here, you can choose from the most Popular Add-ins. Click on the Add-ins group, then Store. This will take you to the Office Add-ins Store. Browse or search for the add-in you want, then click
on it. In our case, we will search for the People Graph Add-in. Click on Add to install the Add-in. Confirm, then click on Continue. As you can see, you will be given the option to customize the functions and appearance of the Add-in. Click on the Add-in window. A cog icon will appear, indicating access to the Settings. Select the Table icon to
incorporate your data. Highlight your data and click Create. As you can see, the Add-in has helped us create a quick illustration of the data. Installing Third-Party Add-ins Go to the website of the Add-in maker. In our example, we will go to extendoffice.com. Click on Download Now to download it to your computer. Locate the downloaded file in your
computer and extract. Double-click on the file to Open. Accept the License Agreement and Install the file. Click on the File tab in Excel. Select Options. Go to Add-ins on the left. Select Manage at the bottom, then select Excel Add-ins. Click Go. Click the Browse button. Locate the downloaded file on your computer. Click OK to install. Confirm that you
want to install the Add-in. As you can see, the Add-in has been successfully integrated to Excel. Unblocking an Excel Add-in File Some users may have trouble accessing the Add-in even after successfully installing it and adding to the Ribbon. This is because Windows might have deemed the file to be a security risk. To unblock a file, follow these steps:
Search for the Excel Add-in file you want to unblock. Make sure that the Add-in file is located in the Documents folder. Click on the File tab in Excel. Select Options. Go to the Trust Center. Click on Trust Center Settings. Then, Trusted Locations. Go to Add new location. Click on Browse to choose the folder. Click OK. Tick the Subfolders of this
location are also trusted checkbox. Click OK. Close and reopen Excel. As you can see, Excel has recognized the file without any restriction. Fortunately, you only have to unblock a file once. Note: Some Add-ins from less than reputable sites may carry viruses. Do your due diligence and download only from trusted websites. Removing an Excel Add-in If
you find that you no longer have the need for an Add-in, you can opt to remove it from Excel. To remove an Add-in, follow these steps: Go to the Home tab. Click on Add-ins. Then, Get Add-ins. Go to MY ADD-INS. From here, you will see a list of your installed Excel Add-ins. Click on the one you want to remove. Click on the 3 dots on the upper right-
hand corner of the Add-in to access the options menu. Click on the Remove button. Click on Remove to confirm. Deactivate an Excel Add-in If you want to temporarily deactivate an Add-in, follow these steps: Click on the File tab in Excel. Go to Options, then select Add-ins. Go to Manage Add-ins. From there, locate the Add-in you want to inactivate.
Untick the checkbox to Deactivate the Add-in. Click OK. Conclusion There you have it! If you followed all the steps above, you should be able to install and use Excel Add-ins with ease. Hopefully you can use the Add-ins to your advantage in your next Excel project. Download our 141 Free Excel Templates and Spreadsheets. See also The Ultimate
Guide to Drag Formulas Down in Excel All BlogsExcel ResourcesAdd-ins in ExcelData Analysis and ToolsAdd-InsAdd-ins in ExcelAnalysis ToolPak In ExcelData ConsolidationConsolidate Function In ExcelData Analysis and ToolsGET: WSM ALL COURSES ACCESSDownload FREE Add-ins Excel Template and Follow Along!Add-ins Excel
Template.xlsxTable Of ContentsAn add-ins is an extension that adds more features and options to Microsoft Excel. Providing additional functions to the user increases the power of Excel. An add-in needs to be enabled for usage. Once enabled, it activates as Excel is started.For example, Excel add-ins can perform tasks like creating, deleting, and
updating the data of a workbook. Moreover, one can add buttons to the Excel ribbon and run custom functions with add-ins.The Solver, Data Analysis (Analysis ToolPak), and Analysis ToolPak-VBA are some essential add-ins.The purposes of activating add-ins are listed as follows: -To interact with the objects of ExcelTo avail an extended range of
functions and buttonsTo facilitate the setting up of standard add-ins throughout an organizationTo serve the varied needs of a broad audienceln Excel, one can access several Add-ins from “Add-ins” under the “Options” button of the "File" tab. In addition, one can select from the drop-down “Manage” in the “Add-ins” window for more add-ins.By
default, it might hide some add-ins. One can view the unhidden add-ins in the "Data" tab on the Excel ribbon. For example, it is shown in the following image.If Excel is not displaying the add-ins, they need to be installed. The steps to install Excel add-ins are listed as follows: First, click on the “File” tab located at the top left corner of Excel. Click
“Options,” as shown in the following image. The “Excel Options” window opens. Select “Add-ins.” There is a box to the right of "Manage" at the bottom. Click the arrow to view the drop-down menu. Select "Excel add-ins" and click "Go." The “Add-ins” dialog box appears. Select the required checkboxes and click “OK.” We have selected all four add-ins.
The “Data Analysis” and “Solver” options appear under the “Data tab” of the Excel ribbon. The types of add-ins are listed as follows:Inbuilt add-ins: These are built into the system. One can unhide them by performing the steps listed under the preceding heading (how to install add-ins in Excel?).Downloadable add-ins: These can be downloaded from
the Microsoft website (www.office.com).Custom add-ins: These are designed to support the basic functionality of Excel. They may be free or chargeable. ChartExpo is an example of a custom add-in, offering advanced charting tools to enhance Excel's data visualization capabilities. The "Data Analysis Tools" pack analyzes statistics, finance, and
engineering data.The various tools available under the "Data Analysis" add-in are shown in the following image.Generally, an add-in is created with the help of VBA macros. Let us learn to create an add-in (in all Excel files) for a custom function. For this, first, we make a custom function.Let us consider some examples.We want to extract comments
from specific cells of Excel. Then, create an add-in for the same.The steps for creating an add-in and extracting comments from cells are listed as follows: Step 1: Open a new workbook. Step 2: Press the shortcut “ALT+F11” to access the “Visual Basic Editor.” The following image shows the main screen of Microsoft Visual Basic for Applications. Step
3: Click “Module” under the “Insert” tab, shown in the following image. Step 4: Enter the following code in the “module” window. Function TakeOutComment(CommentCell As Range) As StringTakeOutComment = CommentCell. Comment.TextEnd Function Step 5: Once the code is entered, save the file with the type “Excel add-in.” Step 6: Open the
file containing comments. Step 7: Select " Options " in the "File" tab and select "Options." Choose "Add-ins." In the box to the right of "Manage," select "Excel Add-ins." Click "Go." Click the "Browse" option in the "Add-ins" dialog box. Step 8: Select the add-in file that had been saved. Click “Ok.” We saved the file with the name "Excel Add-in." Step 9:
The workbook's name (Excel Add-in) that we had saved appears as an add-in, as shown in the following image. This add-in can be applied as an Excel formula to extract comments. Step 10: Go to the sheet containing comments. The names of three cities appear with comments, as shown in the following image. Step 11: In cell B1, enter the symbol
"equal to" followed by the function's name. Type "TakeOutComment," as shown in the following image. Step 12: Select cell Al as the reference. It extracts the comment from the mentioned cell. Since there are no comments in cells A2 and A3, the formula returns “#VALUE!.”We want to hide Excel worksheets except for the active sheet. Create an
add-in and icon on the Excel toolbar for the same.The steps to hide worksheets (except for the currently active sheet) and, after that, create an add-in and icon are listed as follows: Step 1: Open a new workbook. Step 2: In the “Visual Basic” window, insert a “Module” from the Insert tab. The same is shown in the following image. Step 3: Copy and
paste the following code into the module. Sub Hide All Worksheets ()Dim As WorksheetFor Each Ws In ActiveWorkbook.WorksheetsIf Ws.Name ActiveSheet.Name ThenWs.Visible = xISheetVeryHiddenEnd IfNext WsEnd Sub Step 4: Save this workbook with the type “Excel add-in.” Step 5: Add this add-in to the new workbook. For this, click “Options”
under the “File” tab. Select “Add-ins.” In the box to the right of “Manage,” select “Excel add-in” Click “Go.” In the “Add-ins” window, choose “Browse.” Step 6: Select the saved add-in file. Click “Ok.” We have saved the file with the name “Hide All Worksheets.” Step 7: The new add-in “Hide All Worksheets” appears in the “Add-ins” window. Step 8:
Right-click the Excel ribbon and select “Customize the Ribbon.” Step 9: The “Excel Options” window appears. Click “Quick Access Toolbar.” Under the drop-down of “Choose commands from,” select “macros.” In the box following this drop-down, choose the name of the macro. Then, click “Add” followed by “OK.” The tasks of this step are shown with
the help of black arrows in the following image. Step 10: A small icon appears on the toolbar. Clicking this icon hides all worksheets except for the currently active sheet. If we want to unhide the sheets hidden in the preceding example (example #2). Create an add-in and toolbar icon for the same.The steps to unhide the sheets and, after that, create
an add-in and toolbar icon are listed as follows: Step 1: Copy and paste the following code to the “Module” inserted in Microsoft Visual Basic for Applications. Sub UnHide All HiddenSheets ()Dim Ws As WorksheetFor Each Ws In ActiveWorkbook.WorksheetsWs.Visible = xlSheetVisibleNext WsEnd Sub Step 2: Save the file as “Excel add-in.” Add this
add-in to the sheet. Right-click the Excel ribbon and choose the option "Customize the ribbon." Then, in the "Quick Access Toolbar," select "Macros" under the drop-down of "Choose commands from."Choose the macro's name, click "Add" and "OK." The tasks of this step are shown with the help of black arrows in the following image. Step 3: Another
icon appears on the toolbar. Clicking this icon unhides the hidden worksheets. The points to be observed while working with add-ins are listed as follows: First, remember to save the file in Excel's "Add-in" extension of Excel. Be careful while selecting the add-ins to be inserted by browsing in the "Add-ins" window. Note: It is possible to uninstall the
unnecessary add-ins at any time. Home > Macros > Basics > Add-ins Install and use Excel add-ins to get extra features and commands in your Excel workbooks. See how to unblock new add-ins that are not working, due to Microsoft security settings. Usually, Excel add-ins are installed in Excel's default folder for Add-ins. If you prefer to store add-ins
in a different folder, go to the Use a Different Folder section. To find your default Add-ins folder, you can use either of these methods: Browse for the Addin Folder Use my Excel Addin Folder Path Locator file. Browse for the Addin Folder To manually locate the default Excel AddIns folder, follow the steps below. Click the Developer tab on the Excel
Ribbon. If it isn't visible, follow the steps here. Click the Excel Add-Ins command (icon is a cog shape) In the Add-Ins window, select any add-in in the list, and click the Browse button. That will open the Browse window, at the AddIns folder. Right-click on the path at the top of the Browse window, and click "Copy Address as Text" Click Cancel, to close
the Browse window Click Cancel, to close the Add-Ins window. Open Windows Explorer, and paste the copied address into the address bar, then press Enter How to Use the Excel Addin Folder Path Locator File Download a copy of my Excel Addin Folder Path Locator file. Unzip the file, and store it in a folder on your computer (not the Addins folder)
Next, open the file, and enable macros Go to the AddinsFolder sheet Click the Show Addins Folder Location button. In cell B4, the file path will appear. For example, in Windows 10, it might be located here: C:\Users\UserName\AppData\Roaming\Microsoft\AddIns Click the Open Addins Folder button Windows Explorer will open, and will show the
contents of the Addins Folder. Note: Close Excel before making any changes to the installed Addins How to Install an Excel Add-In Excel 2007 and Later To install an add-in, please follow these steps: In Windows Explorer, open the Microsoft Excel Addins folder on your computer. NOTE: If you aren't sure of the location, you can use the Excel Addin
Folder Path file to find it. If you are using a different folder, see the Use a Different Folder section below. Unzip the add-in file, if necessary, to extract the add-in file -- it will probably have an xlam extension Save the add-in file in your Microsoft Addins folder. NOTE: You can store the add-in in any folder, but it's easier to install if it's stored in the
Addins folder To allow Excel to open the add-in file automatically, you might need to unblock it. Right click on the add-in file and click Properties If the following warning appears, click the Unblock box, to add a check mark -- "This file came from another computer and might be blocked to help protect this computer" Click OK Open the Excel program
In Excel: On the Ribbon, click the Developer tab (if you don't see that tab, follow the instructions here to show it) Click the Excel Add-Ins command (icon is a cog shape). In the Add-in dialog box, add a check mark to add-in's name. Note: If you do not see the add-in in the list, click the Browse button. Navigate to the folder where you saved the xlam
file, and select the add-in file Click OK, to close the window. A new tab for the add-in might appear on the Ribbon, or a new command might appear on one of the existing tabs -- check the add-in notes, for help in locating it. If you don't see a button on the Ribbon, you can add icons to the Quick Access Toolbar, to run the macros. Use a Different Folder
to Store Add-ins Instead of storing your Excel add-in in the default Micrsoft Excel Addins folder, you can use an other folder on your computer. To prevent problems, follow these steps to set that folder as a Trusted Location: In Excel, click the File Tab, and click Options In the list at the left, click Trust Centre Click the Trust Center Settings button In
the list at the left, click Trusted Locations If your folder is not list there, click the Add New Location button Click the Browse button Find and select your folder, and click OK Click OK again, and your folder should appear in the Trusted Location list. Click OK, twice, to close the windows. Add-in Custom Tab Not Showing Due to Microsoft security
updates, some Excel add-ins (mine and others) might not load correctly, and their custom tabs don't appear on the Excel Ribbon. Here are a few solutions you can try. -- Unblock the Add-in File -- Use a Trusted Location -- Check the Ribbon Unblock the Add-in File This is the most common solution to the missing add-in tab. Follow the steps below, to
unblock the file, and it should open correctly. Close Excel, if it is running Open Windows Explorer, and open the folder where you stored the add-in file, usually the Microsoft Addins folder. NOTE: If you aren't sure of the Addins folder location, you can use the Excel Addin Folder Path file to find it. Then, close Excel again. To allow Excel to open the
add-in file automatically, you might need to unblock it. Right click on the add-in file and click Properties If the following warning appears, click the Unblock box, to add a check mark -- "This file came from another computer and might be blocked to help protect this computer" Click OK Then, start Excel, and the custom tab for the add-in should appear
on the Excel Ribbon Use a Trusted Location If your add-in is not stored in the defaault addins folder, the tabs could be missing because your folder is not a Trusted Location. Follow the instructions above, that show how to use a different folder as a Trusted Location for your add-in files. Check the Ribbon In one case that I've heard of, there was a
problem with the Excel Ribbon. Try these steps, if the other solutions don't fix the problem. Right-click on an empty part of the Excel Ribbon, and click Customize the Ribbon In the list at the right, you should only see one tab named Developer If there is a second one, named Developer (Custom), uncheck that tab Then, close the Customize window,
and close and restart Excel. Free Add-ins I use a few free add-ins that make Excel even better, and asked other people what free add-ins they use, and would recommend. I compiled a list, starting with my favourites. Maybe you'll see a few that you can download and install, and make working in Excel a bit easier. Click here to see my list of
recommended free add-ins. Save a File as an Add-in You can create your own add-ins, by storing macros in a file, then saving it as an add-in: Record or create one or more macros in the file On the Excel Ribbon, click the File tab, and click Save As Click the Browse button, to open the Save As window (stay in the selected folder) At the bottom, type a
File Name In the Save As Type drop down, select Excel Add-In (*.xlam) The AddIns folder should be automatically selected Click Save, then close Excel To use your add-in file, follow the steps above, to install it To remove an Excel add-in that you stored in the Addins folder, follow these steps. A) Open the Add-ins Window Use one of these methods to
open the Add-ins window: If the Developer tab is showing on your Excel Ribbon, click that, then click the Excel Add-ins command. OR, click the File tab, then click Options, and click the Add-Ins category. At the bottom of the window, in the Manage drop down list, choose Excel Add-ins, and then click Go B) Inactivate the Add-in After the Add-ins dialog
box opens, follow these steps to inactivate the add-in: In the Add-Ins available list, click on the add-in that you want to inactivate -- its description will appear below the list. Read that, to make sure that it's the add-in that you want to remove Then, remove the check mark beside the Add-in's name Next, click OK, to close the Add-ins window. C) Remove
the Add-in Next follow these steps to remove the add-in file: Close Excel Go to the Addins folder (follow the steps to find it), or the folder where you stored the Excel add-in that you want to remove Delete the add-in file, or move it to a different folder, so it won't open automatically, when Excel starts. Restart Excel, and the add-in will no longer appear.
Get Monthly Excel Tips! Don't miss my monthly Excel newsletter! You'll get quick tips, article links, and a bit of fun. Add your email, and click Subscribe. Next, when you get my reply, click the Confirm button. I add this step to protect you from spam! Related Links Free Excel Add-ins All BlogsExcel ResourcesAdd-ins in ExcelData Analysis and
ToolsAdd-InsAdd-ins in ExcelAnalysis ToolPak In ExcelData ConsolidationConsolidate Function In ExcelData Analysis and ToolsGET: WSM ALL COURSES ACCESSDownload FREE Add-ins Excel Template and Follow Along!Add-ins Excel Template.xlsxTable Of ContentsAn add-ins is an extension that adds more features and options to Microsoft Excel.
Providing additional functions to the user increases the power of Excel. An add-in needs to be enabled for usage. Once enabled, it activates as Excel is started.For example, Excel add-ins can perform tasks like creating, deleting, and updating the data of a workbook. Moreover, one can add buttons to the Excel ribbon and run custom functions with
add-ins.The Solver, Data Analysis (Analysis ToolPak), and Analysis ToolPak-VBA are some essential add-ins.The purposes of activating add-ins are listed as follows: -To interact with the objects of ExcelTo avail an extended range of functions and buttonsTo facilitate the setting up of standard add-ins throughout an organizationTo serve the varied needs
of a broad audienceln Excel, one can access several Add-ins from “Add-ins” under the “Options” button of the "File" tab. In addition, one can select from the drop-down “Manage” in the “Add-ins” window for more add-ins.By default, it might hide some add-ins. One can view the unhidden add-ins in the "Data" tab on the Excel ribbon. For example, it is
shown in the following image.If Excel is not displaying the add-ins, they need to be installed. The steps to install Excel add-ins are listed as follows: First, click on the “File” tab located at the top left corner of Excel. Click “Options,” as shown in the following image. The “Excel Options” window opens. Select “Add-ins.” There is a box to the right of
"Manage" at the bottom. Click the arrow to view the drop-down menu. Select "Excel add-ins" and click "Go." The “Add-ins” dialog box appears. Select the required checkboxes and click “OK.” We have selected all four add-ins. The “Data Analysis” and “Solver” options appear under the “Data tab” of the Excel ribbon. The types of add-ins are listed as
follows:Inbuilt add-ins: These are built into the system. One can unhide them by performing the steps listed under the preceding heading (how to install add-ins in Excel?).Downloadable add-ins: These can be downloaded from the Microsoft website (www.office.com).Custom add-ins: These are designed to support the basic functionality of Excel. They
may be free or chargeable. ChartExpo is an example of a custom add-in, offering advanced charting tools to enhance Excel's data visualization capabilities. The "Data Analysis Tools" pack analyzes statistics, finance, and engineering data.The various tools available under the "Data Analysis" add-in are shown in the following image.Generally, an add-in
is created with the help of VBA macros. Let us learn to create an add-in (in all Excel files) for a custom function. For this, first, we make a custom function.Let us consider some examples.We want to extract comments from specific cells of Excel. Then, create an add-in for the same.The steps for creating an add-in and extracting comments from cells
are listed as follows: Step 1: Open a new workbook. Step 2: Press the shortcut “ALT+F11” to access the “Visual Basic Editor.” The following image shows the main screen of Microsoft Visual Basic for Applications. Step 3: Click “Module” under the “Insert” tab, shown in the following image. Step 4: Enter the following code in the “module” window.
Function TakeOutComment(CommentCell As Range) As StringTakeOutComment = CommentCell. Comment.TextEnd Function Step 5: Once the code is entered, save the file with the type “Excel add-in.” Step 6: Open the file containing comments. Step 7: Select " Options " in the "File" tab and select "Options." Choose "Add-ins." In the box to the right
of "Manage," select "Excel Add-ins." Click "Go." Click the "Browse" option in the "Add-ins" dialog box. Step 8: Select the add-in file that had been saved. Click “Ok.” We saved the file with the name "Excel Add-in." Step 9: The workbook's name (Excel Add-in) that we had saved appears as an add-in, as shown in the following image. This add-in can be
applied as an Excel formula to extract comments. Step 10: Go to the sheet containing comments. The names of three cities appear with comments, as shown in the following image. Step 11: In cell B1, enter the symbol "equal to" followed by the function's name. Type "TakeOutComment," as shown in the following image. Step 12: Select cell Al as the
reference. It extracts the comment from the mentioned cell. Since there are no comments in cells A2 and A3, the formula returns “#VALUE!.”We want to hide Excel worksheets except for the active sheet. Create an add-in and icon on the Excel toolbar for the same.The steps to hide worksheets (except for the currently active sheet) and, after that,
create an add-in and icon are listed as follows: Step 1: Open a new workbook. Step 2: In the “Visual Basic” window, insert a “Module” from the Insert tab. The same is shown in the following image. Step 3: Copy and paste the following code into the module. Sub Hide All Worksheets ()Dim As WorksheetFor Each Ws In ActiveWorkbook.WorksheetsIf
Ws.Name ActiveSheet.Name ThenWs.Visible = xISheetVeryHiddenEnd IfNext WsEnd Sub Step 4: Save this workbook with the type “Excel add-in.” Step 5: Add this add-in to the new workbook. For this, click “Options” under the “File” tab. Select “Add-ins.” In the box to the right of “Manage,” select “Excel add-in” Click “Go.” In the “Add-ins” window,
choose “Browse.” Step 6: Select the saved add-in file. Click “Ok.” We have saved the file with the name “Hide All Worksheets.” Step 7: The new add-in “Hide All Worksheets” appears in the “Add-ins” window. Step 8: Right-click the Excel ribbon and select “Customize the Ribbon.” Step 9: The “Excel Options” window appears. Click “Quick Access
Toolbar.” Under the drop-down of “Choose commands from,” select “macros.” In the box following this drop-down, choose the name of the macro. Then, click “Add” followed by “OK.” The tasks of this step are shown with the help of black arrows in the following image. Step 10: A small icon appears on the toolbar. Clicking this icon hides all
worksheets except for the currently active sheet. If we want to unhide the sheets hidden in the preceding example (example #2). Create an add-in and toolbar icon for the same.The steps to unhide the sheets and, after that, create an add-in and toolbar icon are listed as follows: Step 1: Copy and paste the following code to the “Module” inserted in
Microsoft Visual Basic for Applications. Sub UnHide All HiddenSheets ()Dim Ws As WorksheetFor Each Ws In ActiveWorkbook.WorksheetsWs.Visible = xISheetVisibleNext WsEnd Sub Step 2: Save the file as “Excel add-in.” Add this add-in to the sheet. Right-click the Excel ribbon and choose the option "Customize the ribbon." Then, in the "Quick
Access Toolbar," select "Macros" under the drop-down of "Choose commands from."Choose the macro's name, click "Add" and "OK." The tasks of this step are shown with the help of black arrows in the following image. Step 3: Another icon appears on the toolbar. Clicking this icon unhides the hidden worksheets. The points to be observed while
working with add-ins are listed as follows: First, remember to save the file in Excel's "Add-in" extension of Excel. Be careful while selecting the add-ins to be inserted by browsing in the "Add-ins" window. Note: It is possible to uninstall the unnecessary add-ins at any time. Add-ins in Excel allow users to extend the program’s functionality across
various platforms that include Windows, Mac, etc. In addition, the users can add customized features and commands to the Excel application for easy access. Add-ins in Excel support better user interaction with Excel objects and enable them to manipulate their data in a spreadsheet more efficiently. For example, the table below shows the amount of
DEM (Deutschmark) in cell A2. We can convert it to Euros using the manage Add-ins in Excel and display the converted currency in cell D2. In this example, we can activate the Euro Currency Tools Add-ins to determine the required value. [Note: In the image below, the Euro Currency Tools is already enabled. So, it is visible in the ribbon]. Select the
“Formula” tab > go to the “Solutions” group > click the “Euro Conversion” option. The “Euro Conversion” window pops up. Enter the required details, as shown in the above image, and complete the required calculations. Then, click on “OK”. In cell D2, we have the converted amount. Similarly, we can activate and show Add-ins in Excel ribbon, best
suiting the requirements and daily task demands. Add-ins in Excel are additional features that extend the application’s capabilities, thus making it more interactive. The three types of Add-ins are, Excel Add-ins that are already in the application. We have to enable them. Downloadable Add-ins that we can download from the internet. Custom Add-ins
built using VBA Macros and add them in the Excel ribbon. We can enable the existing inactive Add-ins by choosing File > Options > Add-ins > Go... to open the Add-ins window. Then, select the required Add-ins and click “OK” to use them. When some of the Excel features are not visible in the Excel ribbon, we must first enable them. The steps to
install or enable Add-ins In Excel are: Step 1: Select the “File” tab. Step 2: In the File menu, choose “Options” from the file menu. Step 3: The “Excel Options” window opens. On the left, click the “Add-ins” option, on the right, the “Manage” field should be “Excel Add-in” [If not, select from the drop-down], click on “Go...”, as shown below. Step 4: The
moment we press “Go...” the “Add-ins” window pops up. Check/tick the required Add-ins checkbox for the worksheet. For example, to access Data Analysis and Solver functionalities, choose “Analysis ToolPak” and “Solver Add-ins” from the list, as shown in the below image, and click “OK”. Now, the Data Analysis and Solver Add-ins are enabled and
are visible in the Data tab. Thus, we can install and manage Add-ins in Excel from the “File” tab and the “Add-ins” window. Excel VBA - All in One Courses Bundle (35+ Hours of Video Tutorials) If you want to learn Excel and VBA professionally, then Excel VBA All in One Courses Bundle (35+ hours) is the perfect solution. Whether you’re a beginner
or an experienced user, this bundle covers it all - from Basic Excel to Advanced Excel, Macros, Power Query, and VBA. There are three types of Add-ins in Excel, namely, Excel Add-ins. Downloadable Add-ins. Custom Add-ins. These are the inbuilt Add-ins in Excel. They typically have the extensions, .xlam, .xla, and .xll. Some examples are The Euro
Currency Tools and Analysis ToolPak, seen in the previous sections. We can download some Add-ins from the internet to perform specific tasks. For example, we can download from the Microsoft website and show Add-ins in Excel ribbon, using the steps explained in the previous section. We can use the Custom Add-ins to standardize our daily tasks.
First, we use VBA code to build them. For example, the below image shows Custom Add-ins. It is visible in the Add-ins window because it is a VBA Macro saved as an Excel Add-in, as shown below. Therefore, whether it is an inbuilt, downloadable, or custom Add-ins, we must check/uncheck the respective Add-ins checkbox to enable/disable Add-ins in
Excel. The Data Analysis is one of the most-powerful Add-ins. It finds its application in finance, statistical data analysis, and engineering domains. Once the Analysis ToolPak Add-ins are enabled, they will be in the Data tab. When we click the Data Analysis option, the Data Analysis window opens. Here, we can choose the required function and click
OK to execute it. These Add-ins are useful when we need analysis, such as Regression and t-Tests. We will understand the Excel Add-in with some advanced scenarios. We will Create Custom Functions and Install as An Excel Add-in. We will Extract Comments from The Cells Of Excel using the following data table. The table with cells B2:B4 and B11
has comments, and we want to extract the comments from the specific cells into our worksheet. The steps to Extract Comments by creating Excel Add-in are: Step 1: Open a new workbook > select the “Developer” tab > go to the “Code” group > select the “Visual Basic” option, and the “Visual Basic Editor” window opens. [Alternatively, use the
shortcut keys, Alt+F11, to open the “Visual Basic Editor” window]. In the “Visual Basic Editor” window, select the “Insert” tab > click on the “Module” option, as shown below. Step 2: The Module 1 window opens. Enter the custom function shown in the image below to build the Add-ins to extract the comments from the cells in our spreadsheet.
Function ExtractComment(Commentcell As Range) As String ExtractComment = Commentcell. Comment.Text End Function Step 3: Save the file as an Excel Add-in. [By default, the file gets saved in the Microsoft folder. But we can store it in any desired folder. The “Save As” folder is shown below. Step 4: Now, open our worksheet with cells
containing the comments we want to extract, and using the Add-ins, open the Add-ins window. Step 5: Click “Browse” in the Add-ins window to locate the folder where the saved workbook containing the VBA Macro is found. And once we click on “OK”, the workbook will appear in the list. Click “OK” to close the Add-ins window. Step 6: Now, in the
worksheet with cells containing the comments, choose cell C2 and enter the custom function we created as =ExtractComment(B2). We will get the following output in cell C2. [Note: Once we start typing the function name after the ‘=’ sign, it will appear like the rest of the Excel functions beginning with the same letter as the custom function]. Step 7:
Drag the formula from cell C2 to C11 using the fill handle to extract the comments from the remaining cells B3:B11. In the above example, cells B2:B4 and B11 have comments, which the custom function extracts through the activated Excel Add-in. However, in cells C5:C10, the function returns #VALUE! Error because cells B5:B10 do not have
comments. Add-ins in Excel allow us to hide/unhide worksheets, except the current spreadsheet. In such scenarios, we can create and add, Add-in icons to our Excel toolbar for later use. The steps to Hide/Unhide Worksheets by creating Excel Add-in are: Step 1: Open a new workbook a select the “Developer” tab > go to the “Code” group > select the
“Visual Basic” option, and the “Visual Basic Editor” window opens. In the “Visual Basic Editor” window, select the “Insert” tab > click on the “Module” option. Step 2: The Module 1 window opens. Enter the VBA code shown in the image below to hide all worksheets, and save the workbook with the Excel Add-in file type. Sub Hide Worksheets() Dim
Ws As WorksheetFor Each Ws In activebook.WorksheetsIf Ws.Name ActiveSheet.Name ThenWs.Visible = xISheetHiddenEnd IfNext Ws End Sub Step 3: Now, open the workbook where we want the Add-ins icon to hide worksheets. In the workbook, select the “File” tab > click the “Options” in the file menu. Step 4: The “Excel Options” window opens.
On the left, click the “Add-ins” option > on the right, click on “Go...”, as shown below. Step 5: Click the “Browse” option in the Add-ins window. Select the file with the VBA Macro to hide worksheets. Once we click “OK”, the workbook gets listed, with its box checked in the Add-ins window. Click OK to close the Add-ins window. Step 6: Right-click on
the Excel ribbon and choose the “Customize Quick Access Toolbar” option. Step 7: The “Quick Access Toolbar” window pops up. Set the “Choose command from:” drop-down as “Macros” > select the “Hide Worksheets” option > click on the “Add” button, as shown below. The chosen command gets added to the “Customize Quick Access Toolbar:” list.
Once we click “OK”, we will get the Add-ins icon in the Excel ribbon, as shown below. When we click the Hide Worksheets Add-ins icon, all sheets are hidden except the active worksheet. Step 8: Open another module and enter the VBA code, as shown below, to unhide worksheets and save the workbook with the file type Excel Add-in. Sub
Unhide Hidden Worksheets() Dim Ws As WorksheetFor Each Ws In activebook.WorksheetsWs.Visible = xISheetVisibleNext Ws End Sub Step 9: Repeat steps 2 to 7 to get the Add-ins icon for Unhide Hidden Worksheets. Open the workbook where we want to unhide worksheets. Then open the “Add-ins” window and click on “Browse”. Next, access the
workbook containing the VBA code to unhide worksheets from the location where we saved the file. Step 10: Once we click “OK”, the workbook gets listed, with its box checked in the Add-ins window. Step 10: Now customize the “Quick Access Toolbar”. Once we click “OK”, we will get the Add-ins icon in the Excel ribbon, as shown below. And, when
we click on the Unhide Hidden WorkSheets Add-ins icon, all hidden worksheets will be unhidden or visible. We will use Add-ins in Excel to perform mathematical calculations over a cell range. The following table shows the Physics marks of 10 students, and we have to find the least score. We must write a VBA Macro and create an Add-ins icon to
determine the minimum value. The steps to Perform Mathematical Calculations Over A Cell Range by creating Excel Add-in are: Step 1: Open a new workbook and the “Visual Basic Editor”. Next, go to “Insert” > “Module”. Enter the VBA code shown in the image below in the module window to show the least value in a cell range. Then, save the
workbook as an Excel Add-in. Sub Highlight Minimum Value() Dim Cell As RangeFor Each Cell In Selectionlf Cell = WorksheetFunction.Min(Selection) ThenCell.Font.Color = RGB(255, 0, 0)End IfNext Cell Download Article Download Article This wikiHow teaches you how to use Microsoft Excel's Solver tool, which allows you to alter different
variables in a spreadsheet in order to achieve a desired solution. You can use Solver in both Windows and Mac versions of Excel, though you'll have to enable Solver before you can begin using it. 1 Open Excel. Click or double-click the Excel app icon, which resembles a green box with a white "X" on it. Solver comes pre-installed with both Windows
and Mac versions of Excel, but you'll have to enable it manually. 2 Click Blank workbook. This will open the Excel window, from which point you can proceed with enabling Solver. If you have an existing Excel file you'd like to use Solver with, you can open it instead of creating a new file. Advertisement 3 Click File. It's a tab in the upper-left side of the
Excel window. On a Mac, click Tools instead, then skip the next step. 4 Click Options. You'll find this option at the bottom of the File menu. Doing so brings up the Options window.[1] 5 Click Add-ins. It's a tab in the lower-left side of the Options window. On a Mac, click Excel Add-ins in the Tools menu. 6 Open the "Add-ins Available" window. Make
sure that the "Manage" text box has "Excel Add-ins" listed in it, then click Go at the bottom of the page. On a Mac, this window will open after clicking Excel Add-ins in the Tools menu. 7 Install the Solver add-in. Check the "Solver" box in the middle of the page, then click OK. Solver should now appear as a tool in the Data tab that's at the top of Excel.
Advertisement 1 Understand Solver's use. Solver can analyze your spreadsheet's data and any constraints you've added to show you possible solutions. This is useful if you're working with multiple variables. 2 Add your data to your spreadsheet. In order to use Solver, your spreadsheet must have data with different variables and a solution. For
example, you might create a spreadsheet documenting your various expenses over the course of a month with the output cell resulting in your money left over. You can't use solver on a spreadsheet which doesn't have solvable data (i.e., your data has to have equations). 3 Click the Data tab. It's at the top of the Excel window. This will open the Data
toolbar. 4 Click Solver. You'll find this option in the far-right side of the Data toolbar. Doing so opens the Solver window. 5 Select your target cell. Click the cell in which you want to display your Solver solution. This will add it to the "Set Objective" box. For example, if you're creating a budget where the end goal is your monthly income, you would
click the final "Income" cell. 6 Set a goal. Check the "Value Of" box, then type your target value into the text box next to "Value Of". For example, if your goal is to have $200 at the end of the month, you would type 200 into the text box. You can also check either the "Max" or "Min" box in order to prompt Solver to determine the absolute maximum or
minimum value. Once you've set a goal, Solver will attempt to meet that goal by adjusting other variables in your spreadsheet. 7 Add constraints. Constraints set restrictions on the values that Solver can use, which prevents Solver from accidentally nullifying one or more of your spreadsheet's values. You can add a constraint by doing the following:[2]
Click Add Click the cell (or select the cells) for which the constraint applies. Select a type of constraint from the middle drop-down menu. Enter the constraint's number (e.g., a maximum or minimum). Click OK 8 Run Solver. Once you've added all of your constraints, click Solve at the bottom of the Solver window. This will prompt Solver to find the
optimal solution for your problem. 9 Review the results. When Solver alerts you that it has an answer, you can see the answer by looking at your spreadsheet to see which values were changed. 10 Change your Solver criteria. If the output that you received isn't ideal for your spreadsheet, click Cancel in the pop-up window, then adjust your objective
and constraints. If you do like your Solver's results, you can apply them to your spreadsheet by checking the "Keep Solver Solution" box and then clicking OK. Advertisement Ask a Question Advertisement Thanks Advertisement Thanks Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Jack
Lloyd. Jack Lloyd is a Technology Writer and Editor for wikiHow. He has over two years of experience writing and editing technology-related articles. He is technology enthusiast and an English teacher. This article has been viewed 645,429 times. Co-authors: 25 Updated: July 28, 2022 Views: 645,429 Categories: Microsoft Excel Print Send fan mail to



authors Thanks to all authors for creating a page that has been read 645,429 times.



